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Topic 1 – Inventor Basics: 

Required Skills: 
On completion of the session, the participants will be able to: 

 Enter the Autodesk Inventor program and navigate the core functions. 

 Modify the grid and sketch settings. 

 Use sketching tools to create a profile of an object. 

 Add constraints to a profile in a sketch. 

 Dimension a sketch. 

 Zoom and pan the sketch. 

 Produce profiles of various shapes using sketching, constraint and 

dimensioning techniques. 

Required Knowledge: 
 Enter the Autodesk Inventor program and navigate the core functions. 

 Modify the grid and sketch settings. 

 

Introduction to Autodesk Inventor: 
Autodesk's Inventor is a parametric solids modelling product used by Engineers 

and Draftspersons to create and detail components.  Those who have used 

Mechanical Desktop will find Inventor strangely familiar as many of the buttons 

and procedures from Desktop appear in Inventor, but they are packed into an entirely 

new, non-AutoCAD user interface.  Although Inventor doesn't run in AutoCAD, it can be 

used to create AutoCAD drawing files, if desired. 

The Inventor program is entered by clicking on the AutoCAD Inventor  icon on the 

Desktop panel.   After loading the screen is shown similar to that in Figure 1.1 below. 

 

Figure 1.1 

From within the AutoDesk Inventor program, standard Engineering parts, Sheetmetal 

components, Weldment and Assemble drawings can be created together with Animated 

Presentations.    

 

Projects: 
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Inventor is capable of creating complex 3D assemblies.  The assemblies are 

made by combining various part files that are either custom to that assembly, or 

that are shared across many different assemblies. This collection of files must be 

organized in such a way to make it easy for the designer to use.  Inventor does this by 

creating what's called Projects. 

A Project organizes the data by creating a Workspace which is a series of directories 

(folders) that all the custom parts and drawings are located for a given assembly.  Some 

Workspace directories may be stored locally on the designer's computer, while others 

may be stored on a server allowing others to work on them at the same time. 

Often  there are many times when part files like fasteners or bearings tend to be reused 

across many assemblies; these part files are stored in folders that are referred to as 

Libraries.  Since Library parts are shared across many different Projects, they are not 

allowed to be edited. 

Inventor supports two types of project file, Single User Projects and Vault Projects.  

Vault projects are used to collaborate on projects with multiple designers. Common files 

are stored in a vault and are never accessed directly. Each designer has a personal 

project that defines where the files are copied for viewing and editing. The vault also 

maintains version history of files as well as additional attributes.  

On selecting the Projects button the Projects dialog box is displayed as shown in Figure 

1.2 with the options to create a New project or look for an existing project using the 

Browse button. 

 

Figure 1.2 

Project files are identified by the .IPJ file extension. 
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New: 

Selecting the New button displays a series of Inventor Projects dialog boxes that are 

used to setup the project file.   

 Step 1 - Figure 1.3: Sets either the Vault or Single User.  ALL of your projects will 

be Single User. 

 Step 2 - Figure 1.4: Sets the location of the Workplace folder and Project name.  

 Step 3 - Figure 1.5: Sets the location of the libraries to be used. 

 

Figure 1.3 

 

Figure 1.4 

 

Figure 1.5 

 

Browse: 

The browse button is used to look for an existing project file created in drives and folders 

using the Choose Project File dialog box shown in Figure 1.6. 
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Figure 1.6 

Once a project has been located, selected and the Open box checked, the operator is 

returned to the Projects dialog box Figure 1.2. 

The project is made current by one of two methods: 

 Double left-clicking on the project name. 

 Click once on the project name then click Apply and then Done. 

 

New: 
The New button allows new files to be created using the New File dialog box in 

Figure 1.7.  The different file types include Engineering Parts, Assemblies and 

Sub-Assemblies, Detail, Assembly and Exploded Isometric Drawings, Weldment 

Assemblies, and Animated Presentations.  The dialog box contains 4 tabs containing 

various preset templates and menus. 
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Figure 1.7 

Standard Parts: 

A variety of engineering components can be created using the Standard button or 

sheetmetal shapes using the Sheetmetal button.  A sheet metal file is an 

extension of the part modelling environment and contains specific sheet metal 

commands to support the creation of sheet metal parts.  Part files are identified by the 

.IPT file. Extension. 

It is important to remember that each part file contains only one part; a separate part 

file for each part in the assembly. 

Assemblies: 

The Assemblies button is used to create engineering assemblies and sub-

assemblies.  A weldment assembly file is an extension of the assembly 

environment and contains specific weldment commands to support the creation of 

weldments.  Assemblies are identified by the .IAM file. Extension. 

Drawings: 

Creates an Inventor drawing file for the preparation of detail and assembly 

drawings.  Drawings are identified by the .IDW file. Extension. 

Presentations: 

Standard.ipn creates an animated presentation.  An assembly presentation contains 

specific presentation commands. Presentations are used to develop exploded views, 

animations, and other stylized views of an assembly to help document the design.  

Presentations are identified by the IPN file. Extension. 

 

Open: 
The open button is used to open an existing inventor file though the Open dialog 

box. Files can be located using the Look in box to locate drives and folders with 

the results being displayed in the Preview area.  
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Figure 1.8 

Drawing Interface: 
On entering the New, the following screen is displayed and contains the ribbon menu, 

browser, graphics screen and context menus. 
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Sketches must be finished with closed loop profiles before they can be extrude.  

The Sketch mode is exited by clicking the Finish Sketch button at the right end of 

the ribbon. 

Ribbon Menu: 

The ribbon is organized into the Model, Inspect,Tools, Manage, View, Environments, 

Vault, Get Started and Sketch tabs.  Each tab contains a series of panels appropriate for 

the tasks. 

Part, assembly, and drawing files open at the same time in which case, the ribbon 

changes to accommodate only the environment of the file in the active window. 

To find the locations of commands on the ribbon, use the search field at the top of the 

application menu. In search results, click a command to see a tooltip and a path to the 

location on the ribbon, and to launch the command. 

All commands are entered using the Buttons, in the Panels on the Ribbon Menus or by 

right clicking the pointing device and select one of the options displayed in the menu 

box.   The only time the keyboard is used is to enter notes and dimensions. 

Figure 1.9 shows the Sketch Panel while Figure 1.10 shows the Model Panel and have 

been divided into two parts for clarity.   

 

 

Figure 1.9 Sketch Panel 

 

 

Figure 1.10 Model Panel 

When a new part is created, the graphics screen automatically displays the Sketch mode 

with the Sketch Panel displayed on the ribbon. 

Sketches must be finished with closed loop profiles before they can be extrude.  

The Sketch mode is exited by clicking the Finish Sketch button at the right end of 

the ribbon. 
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Browser: 

The browser shows the hierarchical structure of parts, 

assemblies, and drawings. The browser is unique to each 

environment, and always displays the information for the 

active file. 

Turn visibility of the browser on and off with the Browser 

check box located on the ribbon: 

View tab  Arrow Windows panel  User Interface drop-

down list  Select Browser. 

The Browser can be docked on the left or right sides of the 

graphic area. 

 

Figure 1.11 Browser 

Graphics Screen: 

The graphics window displays by default whenever a file is open. If more than one file is 

open, each file appears in its own graphics window. The window containing the file you 

are working on is called the active window. 

Click the cursor inside any displayed graphics window to make it the active window. 

Alternatively, to activate a window to work on, click the file in the Switch drop-down list. 

View tab on the ribbon, Windows panel, on the Switch drop-down list, select the file. 

When more than nine files are open, the More Windows option appears at the bottom of 

the Switch drop-down list. Click More Windows to open the Select Window dialog box, 

where you can activate another file. 

Multiple graphics screens can be arranged in a variety of ways: 

 Overlap or cascade windows.  Select View tab  Windows panel  Cascade. 

 Arrange windows side-by-side, horizontally or vertically. Click View tab  

Windows panel  Tile. The number of open files determines the horizontal or 

vertical ordering of the display. 

 View the active part model or assembly in a separate window, but with a different 

zoom ratio or view orientation. Select View tab  Windows panel   New. The 

new window displays the currently open file. You can change the zoom ratio or 

view orientation. To view both windows simultaneously, use Cascade, or Tile. 

 

When working in Inventor: 

 When a command requires further steps in the process, a message is displayed at 

the far bottom left indicating the next step.  If no command is active, the 

message Ready, or, Press F1 for more help displays on the far bottom left. 

 On 32-bit operating systems, the capacity meter displays on the far right, and 

provides information about the current state of memory consumption. The 

capacity meter is not available on 64-bit operating systems. 

 If more than one document is open, the commands Cascade, Arrange, and Open 

Documents, display at the bottom of the graphics window. 

Sketches must be finished with closed loop profiles before they can be extrude.  

The Sketch mode is exited by clicking the Finish Sketch button at the right end of 

the ribbon. 
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Context Menu: 

In the Autodesk Inventor software, context menus provide a list of common functions 

that are active for the current selection.  

The Context menus are accessed by right-clicking in the graphics screen. The menus are 

available for a specific selection, and when there is no selection, each environment 

provides a context menu. 

Some of the selections on the context menus are not available at all times. 

Figure 1.12 show the Context menu displayed on the graphics screen while working in 

the Sketch mode while Figure 1.13 shows a Context menu displayed while working in the 

model mode. 

 

Figure 1.12 2D Sketch Mode 

 

Figure 1.13 Model Mode 

 

Tutorial Exercise 1-1: 

Enter the Inventor Program create a project in your Tutorial Exercises work area called 

Tutorials and then create a new part file using the metric standard template.  

Procedure: 

1. Enter the Inventor program by clicking on the AutoCAD Inventor  icon. 

 

Create a Project. 

2. Select the Projects  button. 

3. In the dialog box click New. 

4. Click the New single user project and then click Next. 

5. In the Project Name box type Tutorials. 
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6. In the Project (workshop) folder, click on the Browse for project location  

button. 

7. Expand the drives and folders to locate your work area. 

8. Create a new folder in the work area called Tutorial Exercises by clicking the 

Make new folder button, type Tutorial Exercises and then click OK. 

9. Click Finish. 

 

Make the Project current. 

10. Select Tutorials and click Apply. 

11. Click Done. 

 

 

Create a new part file. 

12. Select the New  icon. 

13. Click the Metric tab, then Standard (mm).ipt  and then click OK. 

14. Click on the Finish Sketch  button on the Ribbon Menu. 

15. Save the work in your work area as TUT 1-1 by clicking the Save  icon. 

 

Adjusting the Settings: 
The settings and options are controlled within the Inventor program using the Document 

Settings and Application Options buttons in the Tools tab on the Ribbon. 

Application Options: 

Application Options controls the look and feel of the program. Selecting the 

Application Options button displays the Application Options dialog box which 

contains 14 tabs on two lines; they are Content Centre, Drawing, Sketch, Part, 

iFeature, and Notebook on the top line and General, Save, File, Colours, Display, 

Hardware, Prompt and Assembly on the bottom line.  The main two tabs when learning 

the program are the Colours and Sketch. 

 

Colours Tab: 

The Colours tab, Figure 1.14, allows the operator to adjust the background colour to suit 

their viewing comfort by the use of one of the nine available colour schemes.  The 

background can be set to 1 colour, gradient or a background image. 

The gradient and image backgrounds can slow down some operations such as Orbit 

because they use additional graphics memory.  A solid, single colour background has the 

least impact on the computer’s system resources. 

 Sketch Tab: 

The Sketch tab, Figure 1.15, sets the preferences for sketching.  The main area that you 

may need to constantly change is the Display which controls the visibility of the grid and 

axes.  The various items are turned ON and OFF by clicking the feature to add or remove 

the tick; the selected item is visible when the tick is in the box. 

There is a case for turning the grid and axes OFF, however, the grid and axes are critical 

for placing the part/component on the datum point.  Parts created off the datum point 

can be harder to place in an assembly. 
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Figure 1.14 

 

Figure 1.15 

Document Settings: 

The Document Settings dialog box controls the settings in individual files. Various 

tabs control settings for the active document.  The tabs available are Standard, 

Units, Sketch. Modelling, Bill of Materials, and Default Tolerance.  The main tabs 

to focus on when learning the program are the Units, Figure 1.16, and Sketch, Figure 

1.17. 

 

Units Tab: 

The Units tab, Figure 1.16, controls the physical units of the file.  Length can be changed 

from Metric to Imperial, and measured in millimetres or metres, feet or inches.  Angles 

can be set to operate as degrees or radians.  The precision of both length and angles can 

be set to the required number of decimal points while the dimensions can be displayed 

as values, name, an expression or tolerance. 

 

Sketch Tab: 

The Sketch tab, Figure 1.17, adjusts the grid settings to make it easier to draw the 

sketch by setting the units, Sketch, Modelling and Tolerance settings.   The snap spacing 

sets the spacing between snap points to help with precision when sketching in the active 

part or drawing; the settings for the two axes can have different values. 

The grid display sets the spacing of the lines in the grid display for the active part or 

drawing. The grid consists of two types of lines, major shown as darker lines and minor 

which are more numerous and lighter in colour. 

The snaps per minor setting sets the distance between minor grid lines relative to the 

specified snap distance. For example, if the X snap distance is set at 5, and specify 2 
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snaps per minor, the minor lines are spaced 10 apart.  The major every minor lines 

setting sets the number of minor lines to appear between major lines. 

The auto-bend radius sets the default radius for corner bends that are automatically 

placed on 3D lines as they are drawn. 

 

Figure 1.16 

 

Figure 1.17 

Tutorial Exercise 1-2: 

Change the following settings: Linear precision to 2 decimal places; Angular precision to 

0.1; X/Y snap spacing to 2 mm; Snaps per minor line to 2; Major line every 5 minor 

lines.  Change the background colour to Sky.  Display the grid, axes, and minor lines and 

make sure the snap to grid is selected. 

Procedure: 

Change the Document Settings. 

1. Click the Tools tab on the Ribbon menu to display the Options panel. 

2. Click the Document Settings tab and then the Units tab. 

3. Expand the “Linear Dim Display Precision” box and select 2.12. 

4. Expand the “Angular Dim Display Precision” and select  0.1. 

5. Click the Sketch tab. 

6. Type 2 in the X & Y Snap Spacing boxes. 

7. Change the Snaps per Minor in the Grid display to 2. 

8. Change the Minor Lines in the Grid display to 5. 

9. Click OK to exit the dialog box. 

 

Change the Application Options. 

10. Click the Application Settings tab. 

11. Click the Colours tab and then click on Sky. 

12. Expand the Background box and select 1 Colour. 

13. Click the Sketch tab and check the boxes besides “Grid”, “Axes”, “Minor 

Lines” and “Snap to Grid” to place a tick in the box to activate the option. 

14. Click Apply and then Close to exit the dialog box. 

15. Save the file by clicking the Save  icon. 
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Navigation of the Drawing: 
The methods of navigation consist of three methods for viewing the object or assembly 

from different directions; they are the View Cube, Steering Wheel and the Navigation 

Bar.  An operator may use all three methods but most will become comfortable in using 

only one; the three methods provide basically the same result. 

The visibility of the navigation tools can be turned ON and OFF using the Ribbon. 

Ribbon Menu  View tab  User Interface  Click on the View Cube or Navigation Bar as 

required.  

View Cube: 

The View Cube allows the operator to change between standard planes and isometric 

views.  The Front, Rear, Top, Bottom, Left and Right views look directly onto the view 

and are set by clicking on one of the sides of the View Cube as shown in Figure 1.18.  

Isometric views are viewed by clicking on one of the six corners of the box as shown in 

Figure 1.19, while two sides can be viewed by clicking on an edge, Figure 1.20. 

The left and right arrows shown in Figure 1.18 allow the view to be rotated 90°.  

Clicking the Home  symbol returns the  

 

Figure 1.18 

 

Figure 1.19 

 

Figure 1.20 

Steering Wheel and Navigation Bar: 

The Steering Wheel Figure 1.21, and Navigation Bar Figure 1.22, combines many of the 

common navigation tools into a single interface and contains the Zoom, Orbit, Pan, 

Rewind, Centre, Look, Up/Down and Walk wedges.  All tools work by moving the cursor 

over the wedge and left-clicking. 

 

Figure 1.21 
 

Figure 1.22 

Zoom: 

The Zoom tool works by dragging the wheel into the position that the part is to be 

zoomed about; when the left button is held down on the Zoom wedge, the pivot symbol 

is displayed and by moving the mouse about the screen, the object zooms In or OUT. 

Orbit: 

Orbit allows the part to be viewed from any angle; when the left mouse button is held 

down over the Orbit wedge the object can be pivoted about the pivot symbol. The 

pivot point is calculated based on the centre of the extents of the selected objects. 
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Pan: 

Changes the cursor to a four-directional arrow used to drag the view in the graphics 

window.   The drawing can also be panned by holding down the center wheel (if 

fitted) on the pointing device and moving the device up, down, left or right 

Rewind: 

The Rewind function allows the automatically saved previous views to be selected and 

displayed from the animation history.  The images appear as thumbnails in the graphics 

area; by holding down the left button and moving the cursor over the different images, 

the view is displayed on the screen. 

 

Centre: 

The Centre tool defines the centre of the current view of the part by bragging the cursor 

over the part.  The sphere indicates the point below the cursor within the part is the 

centre of the view; when the mouse button is released, the model is cantered on the 

sphere. 

Look: 

The Look tool rotates the current view vertically and horizontally; when rotating the 

view, the line of sight rotates about the current eye position.   

Up/Down: 

Unlike the Pan tool, the UP/Down tool is used to adjust the height of the current 

viewpoint along the model's Z axis.  To adjust the vertical elevation of the current view, 

drag up or down.  As the cursor is dragged, the current elevation and the allowed range 

of motion is displayed on a graphical element called the Vertical Distance 

indicator.  

The Vertical Distance indicator has two marks that show the highest (Top) 

and lowest (Bottom) elevation possible for the view.  While changing the 

elevation with the Vertical Distance indicator, the current elevation is 

shown by the bright orange indicator, while the previous elevation is shown 

by the dim orange indicator.  

Walk: 

The Walk tool allows the operator to navigate through a model as if walking through it. 

Once the Walk tool is started, the Centre Circle icon is displayed near the centre of the 

view and the cursor changes to display a series of arrows.  To walk through the model, 

drag the cursor in the direction in which it is to be moved. 

Face View: 

The Face view views the faces of a part from a selected plane.  The view is set by 

left-clicking on the face to be viewed.  

 

2D Sketches: 
The starting point of a design in Autodesk Inventor is to create a Sketch using 2D 

drawing tools (Buttons), which are similar to the AutoCAD command icons, to produce a 

2D Sketch on a Sketch Plane, normally the XY Plane.   All sketches MUST form a closed 

loop; that is each entity (lines, arcs etc) must be joined with no gaps or a smaller entity 

drawn over a larger entity. 
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There are 2 methods that can be used to create a sketch: 

Method 1 – Accurately draw a line by clicking at the start 

point, moving the cursor in the direction for the line and 

then typing the distance on the keyboard before pressing 

the Enter key as shown in Figure 1.23.  

Method 2 - create rough sketches to create the designs, and 

then fine tune them by adding parametric constraints and 

dimensions. 
 

Figure 1.23 

When using this method Sketch close to the size and shape of the object, use simple 

sketches, and then add features to refine the shape.   Constrain all geometry that will 

remain fixed, starting with the smallest elements.   The first task is to create the base 

sketch by drawing some lines.   Start at the origin of the grid (in the centre of the part 

window); as the lines are drawn, watch the lower right of the screen for information 

about the position of the cursor, and the length of the line being drawn. 

The General Dimension and Constraints tools are then used to constrain the sketch 

which can then be turned into parts or sheetmetal objects.   As 2D geometry is created 

on the Sketch Plane, it not only finds key data such as end-points and mid-points, but 

the program automatically draws temporary dashed lines when new geometry aligns to 

existing geometry.  It also infers constraints such as parallel and perpendicular.  The 

latter is particularly impressive because, unlike with most systems, Inventor will 

recognize a perpendicular condition even if the lines are not at exact vertical and 

horizontal angles. 

When drawing an element (line, arc etc) on the 2D Sketch Plane, the cross hairs of the 

cursor will indicate that the element is co-incident with the previously drawn element by 

indicating a “yellow” dot, when the cursor is positioned at the exact endpoint or midpoint 

of the element, a “green” dot will be indicated.  Clicking the left mouse button will pick a 

button and/or draw an element from that point; clicking the right button displays a “Pop 

Menu” that allow several options depending on the stage of the command as shown in 

Figure 1.12 2D Sketch Mode and Figure 1.13 Model Mode. 

The steps in creating a part are: 

 Draw the sketch with lines and arcs. 

 Add constraints. 

 Dimension the shape. 

 Finish the sketch. 

 

Draw Buttons: 
All entities for creating a sketch 

are found in the Sketch Panel on 

the Ribbon and are shown in 

Figure 1.24.  As an element is 

drawn in the graphics area, it may 

be automatically constrained into 

position; the constraint symbol 

displayed near the cursor 

indicated the type of constraint 

being applied – constraints will be 

covered later in this lesson. 

 

Error! Reference source not found.Figure 1.24 

Line: 

A line is the geometry consisting of a straight curve bounded by two endpoints.  

The line button on the Sketch buttonbar chains line segments together and 

creates arcs tangent or perpendicular to existing curves.  Segments and arcs are 

automatically joined by coincident constraints at their endpoints.   The lines are 
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created on the graphics screen by picking a point using the Left Mouse Button (LMB). 

Circle: 

 Center-point circle - Creates a circle defined by a center point and a point on its 

radius. The first click sets center point; the second click specifies the radius. A 

tangent constraint is applied if the second point is on a line, arc, circle, or ellipse. 

 

Tangent circle – Creates a circle tangent to three lines on its circumference. The first 

click sets the tangent point for the circle and the first line. The second click sets 

the tangent point for the circle and the second line. The third point sets the 

diameter of the circle (tangent to the third line). 

Arc: 

Three-point arc - Creates an arc defined by two endpoints and a point on the arc. The 

first click sets the first endpoint, the second sets the other endpoint (chord 

length), and the third point sets the arc direction and radius. 

 

Tangent arc - Creates an arc from the endpoint of an existing curve. The first click (on 

the endpoint of the curve) sets the tangent endpoint. The second point sets the end of 

the tangent arc. 

Center point arc - Creates an arc defined by its center point and two endpoints. The 

first click sets the center point, the second specifies the radius and start point, and 

the third point completes the arc. 

Rectangle: 

Two Point rectangle A rectangle created by clicking two points (diagonal corners) to 

set length and width. Two Point rectangles are aligned with the sketch coordinate 

system. 

Three Point rectangle A rectangle whose length and width is created by specifying 

three points. First and second points set the length and direction of the first side. The 

third point sets the length of the adjacent side. A three-point rectangle can have 

any alignment. 

Spline & Bridge Curve 

Spline - 2D and 3D splines are curves of constantly changing radius that pass through a 

series of fit points which can be partially or fully constrained. 

Bridge Curve - A Bridge Curve is used in a 2-D sketch to create a smooth (G2) spline 

that connects two selected sketch curves. Bridge Curve is typically used to create 

adjoining geometry.   

Ellipse: 

The Ellipse creates an ellipse from a centre point, a major axis, and a minor axis. The 

first click sets the centre point, the second click sets the direction and length of 

the first axis, and the third point can be any point on the ellipse. 

Point: 

Points are used as construction commands to help position sketched geometry.  

Center points look like tiny cross-hairs. Sketch points are deleted when the 

coincident geometry (line, spline) is deleted. 

Fillet & Chamfer: 

Fillet – Places an arc of a specified radius, tangential on perpendicular or parallel lines, 

concentric arcs, intersecting and nonintersecting arcs, elliptical arcs, splines, or 

between arcs and lines.  Multiple fillets may be created in a single command with 

all fillets having the radius specified for the first fillet created; when the first 

radius is modified, all related fillets are automatically updates. 

Chamfer – The Chamfer tool places a chamfer (or bevel) at the corner or intersection of 
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two lines or two nonparallel lines.  The chamfer may be specified as equal distances, two 

unequal distances, or a distance and an angle. 

Polygon: 

  The Polygon tool is used to create polygons containing 3 to 120 sides. 

 

Text & Geometry Text: 

Text – Text is added to a sketch when the text is to be embossed or engraved onto the 

surface of the part. 

 

Geometry Text – Geometry Text is used to create and align text to sketch geometry. 

 

Tutorial Exercise 1-3: 

Produce a sketch of the shape opposite.  DO NOT let the ends of the arcs touch each 

other.  DO NOT worry about the lines being horizontal 

or vertical or about the dimensions as the sketch will be 

used in Tutorial Exercises 1-4 and 1-5 to complete the 

sketch. 

Procedure: 

Draw the straight lines at Points A, B, C, & D. 

1. Click on the Line button  in the Sketch 

panel. 

2. Click on any point on the screen to create the beginning of the line at Point A. 

3. Move the cursor down and to the left and then click to create the line ending 

at Point B. 

4. Move the cursor to Point C and click. 

5. Move the cursor to Point D and click. 

6. Right click and select Done. 

 

Draw the arcs  at Points D to E, F to G & A to H. 

7. Click on the Three Point Arc button in the Sketch panel. 

8. To select the 1st end of the arc, move the cursor over Point D and click when 

the dot at the centre of the cursor shows green. 

9. Move the cursor to the left and up and click to create the other endpoint of 

the arc at Point E. 

10. Move the cursor to create an approximate shape and left click. 

11. Move the cursor to Point F similar to that shown and click to start the arc. 

12. Move the cursor down and to the left to create the arc’s endpoint at Point G. 

13. Move the cursor to create an approximate shape and left click. 

14. Move the cursor over Point A and click when the dot at the centre of the 

cursor shows green. 

15. Move the cursor up ad to the right to create the arc’s endpoint at Point H. 

16. Move the cursor to create an approximate shape and left click. 
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Constraints: 
A constraint defines how the entities within a sketch can change 

shape or size.  Geometric constraints control the shape and 

relationships among sketch lines and arcs.  Dimensional constraints 

control the size of sketch geometry. 

12 geometric constraint buttons are located on the Constraints Panel 

as shown Figure 1.25.    
 

Figure 1.25 

Coincident: 

The Coincident constraint constrains two points together or one point to a curve. When 

the constraint is applied to the centre points of two circles, arcs, or ellipses, the 

result is the same as that of a concentric constraint. 

 

Before     After 

Colinear: 

Causes two lines or ellipse axes to lie along the same line. 

 

Before     After 

Concentric: 

Constrains two arcs, circles, or ellipses to the same centre point.  The result is the 

same as that of a coincident constraint applied to the centre points of the curves. 

 

Before     After 

Parallel: 

The parallel constraint causes two or more lines or ellipse axes to be constrained 

parallel to one another. In a 3D sketch, the parallel constraint is parallel to x, y, or 

z part axes unless it is manually constrained to selected geometry. 

 

Before     After 
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Perpendicular: 

Causes selected curves or ellipse axes to lie at right angles to one another.  To 

add a perpendicular constraint to a spline, the constraint must be applied endpoint 

to endpoint between the spline and the other curve. 

 

Before     After 

Horizontal: 

Causes lines, ellipse axes, or pairs of points to lie parallel to the X axis of the sketch 

coordinate system.  A sketch point is automatically created on a midpoint when it 

is constrained.  Two points (curve ends, center). 

 

Before     After 

Vertical: 

Causes lines, ellipse axes, or pairs of points to lie parallel to the Y axis of the sketch 

coordinate system.  A sketch point is automatically created on a midpoint when it is 

constrained. Two points (curve ends, center) 

 

Before     After 

Tangent: 

Constrains two curves to be tangent to one another, even if they do not physically share 

a point (in a 2D sketch). Tangency is commonly used to constrain an arc to a line.  

A tangent constraint is required to specify how to end a spline that is tangent to 

other geometry. 

 

Before     After 

Smooth: 

The Smooth command is used to create a curvature continuous (G2) condition 

between a spline and another curve, such as a line, arc, or spline. The Smooth 

constraint is available in a 2D or 3D sketch or a drawing sketch. 
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Before     After 

Symetric: 

Causes lines and arcs to become aligned symmetrically about a selected line.  Symmetry 

constraints are added to the selected geometry.  Selected lines and arcs are 

constrained about a line to create a symmetrical shape. 

 

Before     After 

In the example above, Line 1 would be selected first and Line 2 second.  Line 3 becomes 

the centreline about which all other lines are placed and needs to be selected only the 

once. 

Equal: 

Resizes the selected arcs and circles to the same radius or selected lines to the same 

length. 

 

Before     After 

Fixed Point (Locked): 

The fixed constraint causes points or curves to be constrained to a fixed location relative 

to the sketch coordinate system. Projected (reference) geometry cannot be fixed.  

If the sketch coordinate system is moved or rotated, fixed curves or points move 

with it. 

 

Displaying Constraints: 
 The Display Constraints button is used to Show Constraints tool on the 2D 

Sketch or 3D Sketch toolbar to view constraints for individual lines and curves.    

The display for all elements can be displayed by right clicking the pointing device 

and selecting Display all Constraints or by pressing the function key F8.   To hide all 

constraints, right-click, and then select Hide All Constraints or by pressing the function 

key F9. 

1 2

3



MEM09004A – Autodesk Inventor (Basic) 

Topic 1 – Inventor Basics 

BlackLine Design    Page 26 of 34 
14th April 2013 – Version 1 

 

Individual groups of constraints can be hidden by clicking on the Hide Constraint button 

 at the end of the group. 

 

Deleting Constraints: 
A constraint can be deleted by moving the cursor over the particular constraint, right 

click the pointing device and then select Delete.   When a constraint is deleted from one 

element, the constraint on the corresponding element is also deleted.  Moving the cursor 

over a constraint highlights the both elements. 

Tutorial Exercise 1-4: 

Continuing with Tutorial Exercise 1-3, add 

constraints to the sketch so the final shape looks 

similar to that shown: 

Procedure: 

Constrain the arcs to each other. 

1. Expand the constraints in the 2D 

Sketch panel by clicking the triangle next to the Perpendicular  button and 

then select the Coincident  button.  

2. Select the end of the left arc at Point H. 

3. Select the end of the center arc at Point G.  The arcs are joined but are NOT 

tangential to each other. 

4. Select the end of the right arc at Point E. 

5. Select the end of the center arc at Point F.  The arcs are joined but are NOT 

tangential to each other. 

Constrain the arcs and straight lines to form tangents. 
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6. Expand the constraints in the 2D Sketch panel by clicking the triangle next to 

the Coincident  button and then select the Tangent  button. 

7. Select the straight line AB. 

8. Select arc AH that connects to the straight line.  The line and arc are now 

tangential. 

9. Select the straight line CD. 

10. Select arc DE that connects to the straight line.  The line and arc are now 

tangential. 

11. Select the arc DE. 

12. Select the arc FG.   The arcs are now tangential. 

13. Select the arc AH. 

14. Select the arc FG.   The arcs are now tangential. 

Constrain lines AB & CD vertical. 

15. Expand the constraints in the 2D Sketch panel by clicking the triangle next to 

the Tangent  button and then select the Vertical  button. 

16. Select the straight line AB. 

17. Select the straight line CD. 

Constrain line BC horizontal. 

18. Expand the constraints in the 2D Sketch panel by clicking the triangle next to 

the Vertical  button and then select the horizontal  button. 

19. Select the straight line BC. 

Constrain the lines AB & CD to the same length and the arcs to the same radius. 

20. Expand the constraints in the 2D Sketch panel by clicking the triangle next to 

the horizontal  button and then select the Equal  button. 

21. Select the straight line AB. 

22. Select the straight line CD. 

23. Select the arc AH. 

24. Select the arc FG. 

25. Select the arc DE. 

26. Select the arc FG. 

Constrain the lines AB & CD so the sketch is symmetrical about the centerline. 

27. Expand the constraints in the 2D Sketch panel by clicking the triangle next to 

the Equal  button and then select the Symmetric  button. 

28. Select the straight line AB. 

29. Select the straight line CD. 

30. Select the unnamed centerline. 

Save the work. 

31. Save the file in your work area as TUT1-3. 
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Dimensioning the Sketch: 
Dimensions are added to the sketch to control the size of a part and can be expressed as 

numeric constants, as variables in an equation, or in parameter files.   Parametric 

dimensions resize the geometry when a dimension valve is changed; the ability of the 

sketch being driven by the dimensions (and constraints) reduces the need for sketching 

exact lengths and angles etc.   When a sketch dimension is edited, its position adjusts as 

the sketch geometry updates. As the sketch is orbited, the dimension text remains 

parallel to the bottom of the screen to allow easy reading as shown in Figure 1.26. 

 

Figure 1.26 

 

General Dimension: 

The General Dimension button is used on the Sketch buttonbar to add dimensions 

to a sketch.   Dimensions can be added to the sketch by several methods, and 

depending on the entity selected.    Dimensions can be added by: 

 Selecting the geometry from the graphics window and dragging the displayed 

dimension to a position near the sketch. 

 Linear dimensions for curves are added by selecting the curve and then 

dragging the displayed dimension to a position near the sketch.   

 Linear dimension between two points, two curves, or a curve and a point, are 

added by clicking at each endpoint of the line or curve and then dragging the 

displayed dimension to a position near the sketch.  

 Radial or diametric dimensions are added by clicking arc or circle. Right-click 

and select Radius for an arc or circle or Linear for a centerline.  

 To add angular dimensions, select two curves or lines and then position the 

dimension. 

 An aligned dimension is placed on the sketch by selecting the points or line, 

and then clicking the right mouse button and selecting “Aligned” from the 

options in the menu. 

When the dimension is added to the drawing the Edit Dimension dialog box is displayed.   

The desired dimension is typed directly into the dialog box, and applied to the sketch by 

clicking the “tick” displayed in the lower right corner of the 

dialog box or pressing the Enter key. 
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Editing Dimensions: 

Dimensions can be edited simply by moving the cursor over the dimension in the Sketch 

Mode and then double left clicking on the dimension.   The Edit Dimension dialog box is 

displayed where the new dimension can be directly typed.    

Automatic Dimension: 

The Automatic Dimension button 

adds dimensions and fully 

constrains the sketch and is used in 

addition to the General Dimension button 

to place critical dimensions.    The 

program remembers which dimensions 

are placed with the General Dimension 

and Automatic Dimension buttons so that 

specifically added dimensions are not 

replaced by automatic dimensions.   Using 

the Automatic Dimensioning button 

displays the Auto Dimension dialog box. 

 

Curves – Selects geometry to dimension. 

Dimensions – Default is On.  Applies automatic dimensions to the selected geometry. 

Clear the check mark to exclude dimensions. 

Constraints – Default is On. Applies automatic constraints to the selected geometry. 

Clear the check mark to exclude constraints. 

Dimensions Required – Shows number of constraints and dimensions required to fully 

constrain the sketch.   If either Dimensions or Constraints are excluded from the 

solution, the number is removed from the total shown. 

 

Rules for Dimensioning: 
Place dimensions on large elements before small ones to minimize distortion.  First 

define large elements that tend to determine sketch size.  Dimensioning small elements 

first might restrict overall size.   Delete or undo a dimension if it distorts the shape of the 

sketch. 

If a feature sketch is likely to change size, consider leaving some of its elements 

underconstrained.  For example, in sketching a slot, it may be a better to leave its length 

undimensioned.  The slot can then adapt to the required size the part is placed in an 

assembly. 

Use both geometric constraints and dimensions as some constraint combinations may 

distort underconstrained portions of the sketch.  If distortion occurs, undo the last 

constraint placed and consider using a dimension or a different constraint combination. 

At times when the shape of the sketch becomes unmanageable, or if the entity is always 

“over constrained” but it you cannot constrain it to it’s correct length or dimension, it is 

better to delete the entity and redraw it.  Any constraint or dimension should be 

removed and the new entity constrained with little trouble – we hope. 
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Tutorial Exercise 1-5: 

Continue with Tutorial Exercise 1-4 and add the 

dimensions where shown.   Due to the number of 

constraints forming the shape, only 3 dimensions are 

required. 

Procedure: 

1. Click the Dimension  button. 

2. Select line BC.  The dimension is displayed. 

3. Drag the cursor down and click to place the 

dimension. The Edit Dimension dialog box is 

displayed. 

4. Type 85 in the dialog box and click the green tick or press the Enter key. 

5. Select line CD.   The dimension is displayed on the drawing. 

6. Drag the cursor right and click to place the dimension. The Edit Dimension 

dialog box is displayed. 

7. Type 35 in the dialog box and click the green tick or press the Enter key. 

8. Select line CD.   The dimension is displayed on the drawing. 

9. Select arc DE.  The dimension is displayed. 

10. Drag the cursor to the side and click to place the dimension. The Edit 

Dimension dialog box is displayed. 

11. Type 15 in the dialog box and click the green tick or press the Enter key. 

12. Select line AB. 

13. Select the FG. 

14. Drag the cursor up and click to place the dimension.  The Edit Dimension 

dialog box is displayed with the dimension 42.5 (half of 85). 

15. Click the green tick or press the Enter key and the following warning is 

displayed. 

 

Over Constraining the Sketch: 
Inventor tracks all constraints and dimensions, and detects when the constraint or 

dimension being placed, duplicates, coincides or shows inconsistency with the existing 

dimensions and constraints used on the sketch. 

Detection is indicated as shown in Figure 1.27 for constraints and Figure 1.28 for 

dimensions.   
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Figure 1.27 

 

Figure 1.28 

Over constrained dimensions can be displayed on the drawing as “Reference 

Dimensions” and appear inside brackets as shown in Figure 1.29 below.  Reference do 

not control the sketch (or model) size and are intended for checking only when the 

accumulative or overall or location dimensions are not indicated but included with the 

sketch dimensions and constraints.. 

 

Figure 1.29 

Completing the Sketch: 
A sketch must be “Finished” by clicking the Finish Sketch button on the Sketch 

panel or right clicking the pointing device and selecting Finish 2D Sketch before 

it can be saved.   The sketch must always be finished before any other procedure 

can be executed. 
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Skill Practice Exercises  
Skill Practice Exercise 1-1 

Create a fully constrained and dimensioned sketch of the 10 mm thick Stepped Block.   

Save the file in your Skill Practice project folder as MEM30004-SP-101. 

 

Skill Practice Exercise 1-2 

Create a fully constrained and dimensioned sketch of the 10 mm thick Spanner.   Save 

the file in your Skill Practice project folder as MEM30004-SP-102. 

 

  

Skill Practice Exercise 1-1 Skill Practice Exercise 1-2 
 

Skill Practice Exercise 1-3 

Create a fully constrained and dimensioned sketch of the 10 mm thick Crank Arm.   Save 

the file in your Skill Practice project folder as MEM30004-SP-103. 

 

Skill Practice Exercise 1-4 

Create a fully constrained and dimensioned sketch of the 10 mm thick Rocker Arm.   

Save the file in your Skill Practice project folder as MEM30004-SP-104. 

 

 
 

Skill Practice Exercise 1-3 Skill Practice Exercise 1-4 
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Skill Practice Exercise 1-5 

Create a fully constrained and dimensioned sketch of the 12 mm thick Hook Hanger.   

Save the file in your Skill Practice project folder as MEM30004-SP-105. 

 

Skill Practice Exercise 1-6  

Create a 3D model of the Adjustable Y-Clamp which is 18 mm thick using Autodesk 

Inventor; save the file to Skill Practice project folder area as MEM374-SP-106.    

 

 

Skill Practice Exercise 1-7 

Create a 3D model of the 3 mm thick Head Gasket using Autodesk Inventor; save the 

file to your Skill Practice project folder as MEM30004-SP-107.    
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